Carrier® ChillerVu™ (OPN-PSM-SIM) Installation and Start-up Guide
Verify that you have the most current version of this document from www.hvacpartners.com or your local Carrier office.

Important changes are listed in Document revision history at the end of this document.

CARRIER CORPORATION ©2017. All rights reserved throughout the world. i-Vu is a registered trademark of Carrier Corporation. All other trademarks are the property of their respective owners.
# Contents

- **What is the Carrier® ChillerVu™?** .................................................................................. 1
  - Carrier® ChillerVu™ specifications .................................................................................. 2
  - Using expanders .................................................................................................................. 4
  - Safety considerations .......................................................................................................... 4
- **Mounting the Carrier® ChillerVu™** ................................................................................. 5
- **Wiring the Carrier® ChillerVu™ for power** ....................................................................... 6
  - To wire for power ................................................................................................................ 6
- **Installing an expander to the Carrier® ChillerVu™** ............................................................ 7
  - To mount an expander ....................................................................................................... 7
  - To attach expanders .......................................................................................................... 8
  - To wire the expander for power ......................................................................................... 8
  - To set the expander's address .......................................................................................... 9
  - To wire inputs and outputs .............................................................................................. 9
- **Addressing the Carrier® ChillerVu™** .............................................................................. 12
  - To set the controller network MAC address ................................................................... 12
  - To use a default IP address ............................................................................................. 13
  - To obtain an IP address using DHCP ............................................................................. 13
  - To assign a custom IP address ....................................................................................... 14
- **Wiring for communications** ............................................................................................. 15
  - Ethernet, BACnet MS/TP, ARC156, and CCN wiring specifications .................................. 15
  - To wire to a BACnet/ARC156 network .......................................................................... 16
  - Ethernet and BACnet MS/TP wiring specifications ........................................................... 16
  - To wire to a BACnet MS/TP network .............................................................................. 17
  - To connect the Carrier® ChillerVu™ to the Ethernet ....................................................... 18
  - To wire to a BACnet over Ethernet network .................................................................. 18
  - To wire to the BACnet over IP network (DHCP) ............................................................ 18
  - To wire to a BACnet over IP network (assign a custom IP) ............................................ 19
  - To wire to a CCN network .............................................................................................. 20
- **Wiring for third party protocols** ...................................................................................... 22
  - To wire to Modbus RTU on Port S2 .................................................................................. 22
  - To wire to a Modbus over IP network ............................................................................ 23
  - To connect to the LonWorks network using the SLTA-10 ............................................. 23
  - To wire a third-party device ............................................................................................ 24
  - To set a port's baud rate using PuTTY ............................................................................ 25
- **Wiring devices to the Carrier® ChillerVu™’s Rnet port** .................................................... 27
- **Adding the Carrier® ChillerVu™ into the WebCTRL® system** ........................................ 28
  - To prepare to create your system ..................................................................................... 28
  - To create your system in SiteBuilder v6.5 ....................................................................... 28
  - To scan in and download CCN devices ......................................................................... 29
  - To add control programs and graphics in the WebCTRL® interface .............................. 30
  - To configure third party protocols in the WebCTRL® interface ................................... 31
- **Configuring CCN PIC files to communicate with Chiller Manager** .............................. 33
  - To set up the driver ......................................................................................................... 35
  - Driver ............................................................................................................................ 35
  - Device ............................................................................................................................ 36
  - Notification Classes ....................................................................................................... 37
  - Calendars ........................................................................................................................ 38
  - Common and Specific Alarms ....................................................................................... 38
  - Custom Translation Tables ............................................................................................ 38
  - BACnet router properties ............................................................................................... 39
## Contents

BACnet firewall.......................................................................................................................... 40
Protocols ........................................................................................................................................ 40
Xnet ............................................................................................................................................. 40

### Communicating through the Local Access port with a USB Link

- To communicate using PuTTY .................................................................................................. 42
- To set up a Local Access connection in the WebCTRL® interface ........................................... 44

### Troubleshooting

- Controller LED's ...................................................................................................................... 45
- Expander LED's ....................................................................................................................... 46
- To restore factory defaults ....................................................................................................... 47
- To get the Carrier® ChillerVu™'s serial number .................................................................. 47
- To replace the Carrier® ChillerVu™'s battery ...................................................................... 47
- To take the Carrier® ChillerVu™ out of service ................................................................... 48

### Compliance

- FCC Compliance ..................................................................................................................... 49
- CE Compliance ....................................................................................................................... 49

### Document revision history ............................................................................................... 50
The Carrier® ChillerVu™ provides full and advanced chiller plant management using an EquipmentBuilder library of validated algorithms and strategies that enhance operation. You can apply the algorithms as designed or customize them in the EIKON® application. You can also integrate the Carrier® ChillerVu™ with third party equipment using open protocols.

You can select from the following protocols:

- BACnet MS/TP
- BACnet ARC156
- Modbus
- LonWorks Explicit
- CCN
**Carrier® ChillerVu™ specifications**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Driver</strong></td>
<td>drv_psm_x-xxx-xxx</td>
</tr>
<tr>
<td><strong>Maximum number of control programs</strong></td>
<td>999</td>
</tr>
<tr>
<td><strong>Maximum number of BACnet objects</strong></td>
<td>12000</td>
</tr>
<tr>
<td><strong>Maximum number of third-party integration points using the EIKON®</strong></td>
<td>1000</td>
</tr>
<tr>
<td><strong>Power</strong></td>
<td>24 Vac ±10%, 50–60 Hz, 24 VA</td>
</tr>
<tr>
<td></td>
<td>26 Vdc ±10%, 10 W</td>
</tr>
<tr>
<td><strong>10/100 BaseT Ethernet Port</strong></td>
<td>For communication on the Ethernet at 10 or 100 Mbps, half duplex</td>
</tr>
<tr>
<td></td>
<td>For LAN, BACnet/Ethernet, BACnet/IP, and/or Modbus TCP/IP communications</td>
</tr>
<tr>
<td><strong>BACnet port</strong></td>
<td>For BACnet ARC156 communication</td>
</tr>
<tr>
<td><strong>Port S1</strong></td>
<td>5-pin EIA-485 for CCN Network and/or CCN Service Tool connection</td>
</tr>
<tr>
<td></td>
<td>(9600 and 38400 baud)</td>
</tr>
<tr>
<td><strong>Port S2</strong></td>
<td>Configurable EIA-485/EIA-232 for third party network connections, including:</td>
</tr>
<tr>
<td></td>
<td>• BACnet MS/TP @ 9600, 19200, 38400, and 76800 baud</td>
</tr>
<tr>
<td></td>
<td>• Modbus (RTU and ASCII modes) @ 9600, 19200, 38400, and 76800 baud</td>
</tr>
<tr>
<td></td>
<td>• LonWorks (requires SLTA-10 adapter) @ 38400 and 76800 baud</td>
</tr>
<tr>
<td><strong>Rnet port</strong></td>
<td>The standard control programs that are included with the Carrier® ChillerVu™ library do not use communicating sensors or the Equipment Touch.</td>
</tr>
<tr>
<td></td>
<td>A custom control program could allow you to use and connect the following to the Rnet port:</td>
</tr>
<tr>
<td></td>
<td>• Up to 15 ZS sensors (5 per control program)</td>
</tr>
<tr>
<td></td>
<td>• One Wireless Adapter that communicates with up to 15 wireless sensors</td>
</tr>
<tr>
<td></td>
<td>• One Equipment Touch</td>
</tr>
<tr>
<td></td>
<td>• Up to 4 SPT Standard sensors and one SPT Plus, SPT Pro, or SPT Pro-F sensor</td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
<td>ZS sensors, a Wireless Adapter, and an Equipment Touch can share the Rnet, but not SPT sensors.</td>
</tr>
<tr>
<td><strong>Rnet Local Access port</strong></td>
<td>For system start-up and troubleshooting</td>
</tr>
<tr>
<td><strong>Xnet Remote Expansion</strong></td>
<td>For communication with Automated Logic® MEx or Carrier MPC Open XPIO expanders</td>
</tr>
<tr>
<td></td>
<td>Up to 6 expanders with a maximum of 144 points between the Carrier® ChillerVu™ and the expanders</td>
</tr>
<tr>
<td><strong>Microprocessor</strong></td>
<td>32-bit Motorola Power PC microprocessor with cache memory, Fast Ethernet controller, high performance 32-bit communication co-processor, ARCNET communication co-processor, and I/O expansion CAN co-processor</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>16 MB non-volatile battery-backed RAM (with 12 MB available for use), 8 MB Flash memory, 32-bit memory bus</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Real-time clock</td>
<td>Battery-backed real-time clock keeps track of time in event of power failure.</td>
</tr>
<tr>
<td>Battery</td>
<td>10-year Lithium CR123A battery retains the following data for a maximum of 720 hours during power outages: time, control programs, editable properties, schedules, and trends. To conserve battery life, you can set the driver to turn off battery backup after a specified number of days and depend on the archive function to restore data when the power returns. A low battery is indicated by the <strong>Battery low</strong> LED or a low battery alarm in the WebCTRL® application.</td>
</tr>
<tr>
<td>Protection</td>
<td>Incoming power is protected by a replaceable 3 Amp Pico® fuse. Network connections are protected by non-replaceable internal solid-state polyswitches that reset themselves when the condition that causes a fault returns to normal. The power, network, input, and output connections are also protected against transient excess voltage/surge events lasting no more than 10 msec.</td>
</tr>
<tr>
<td>BT485 connector</td>
<td>You attach a BT485 (not included) to a controller at the beginning and end of a network segment to add bias and to terminate a network segment.</td>
</tr>
<tr>
<td>Status indicators</td>
<td>LED's indicate status of communications and low battery status. Seven segment display indicates running, error, and power status.</td>
</tr>
<tr>
<td>Environmental operating range</td>
<td>-20 to 140°F (-29 to 60°C), 10–90% relative humidity, non-condensing</td>
</tr>
<tr>
<td>Physical</td>
<td>Rugged aluminum cover, removable screw-type terminal blocks</td>
</tr>
<tr>
<td>Overall dimensions</td>
<td>Width: 11 5/16 in. (28.7 cm) Height: 7 1/2 in. (19 cm)</td>
</tr>
<tr>
<td>Mounting dimensions</td>
<td>Width: 10 13/16 in. (27.5 cm) Height: 5 in. (12.7 cm)</td>
</tr>
<tr>
<td>Recommended panel depth</td>
<td>2 3/4 in. (7 cm)</td>
</tr>
<tr>
<td>Weight</td>
<td>1.4 lbs (0.64 kg)</td>
</tr>
<tr>
<td>Listed by</td>
<td>UL-916 (PAZX), cUL-916 (PAZX7), FCC Part 15-Subpart B-Class A, CE</td>
</tr>
</tbody>
</table>
Using expanders

You can connect expanders to the Carrier® ChillerVu™ to increase the number of inputs and outputs, up to a total of 6 expanders connected to the Xnet.

The Carrier® ChillerVu™ is compatible with the following expanders:

Automated Logic®
- MEx016u
- MEx48u
- MEx816u
- MEx88u

Carrier®
- MPC Open XPIO48
- MPC Open XPIO816

For details on individual expanders, see the Automated Logic® expander's Technical Instructions or the Carrier MPC Open XP Installation and Start-up Guide.

Safety considerations

⚠️ WARNING  Disconnect electrical power to the Carrier® ChillerVu™ before wiring it. Failure to follow this warning could cause electrical shock, personal injury, or damage to the controller.
Mounting the Carrier® ChillerVu™

**WARNING**
When you handle the Carrier® ChillerVu™:
- Do not contaminate the printed circuit board with fingerprints, moisture, or any foreign material.
- Do not touch components or leads.
- Handle the board by its edges.
- Isolate from high voltage or electrostatic discharge.
- Ensure that you are properly grounded.

Screw the Carrier® ChillerVu™ into an enclosed panel using the mounting slots on the cover plate. Leave about 2 in. (5 cm) on each side of the controller for wiring. See mounting dimensions in Specifications (page 2).

If using expanders, see *Installing an expander* (page 7) before mounting the controller.
Wiring the Carrier® ChillerVu™ for power

**WARNING** Do not apply line voltage (mains voltage) to the controller's ports and terminals.

**CAUTIONS**
- The Carrier® ChillerVu™ is powered by a Class 2 power source. Take appropriate isolation measures when mounting it in a control panel where non-Class 2 circuits are present.
- Carrier controllers can share a power supply as long as you:
  - Maintain the same polarity.
  - Use the power supply only for Carrier controllers.

### To wire for power

1. Turn off the Carrier® ChillerVu™'s power switch to prevent it from powering up before you can verify the correct voltage.
2. Remove primary power from the 24 Vac transformer.
3. Pull the screw terminal connector from the controller's power terminals labeled **Ground** and **24 Vac/26 Vdc**.
4. Connect the transformer wires to the screw terminal connector.
5. Apply primary power to the transformer.
6. Measure the voltage at the Carrier® ChillerVu™'s power screw terminal connector to verify that the voltage is within the operating range of 21.6 - 26.4 Vac.
7. Insert the screw terminal connector into the Carrier® ChillerVu™'s power terminals.
8. Turn on the Carrier® ChillerVu™'s power switch.
9. Verify that the Power LED is on and the Run LED is blinking.
Installing an expander to the Carrier® ChillerVu™

The Carrier® ChillerVu™ is compatible with the following expanders:

Automated Logic®
- MEx016u
- MEx48u
- MEx816u
- MEx88u

Carrier
- MPC Open XPIO48
- MPC Open XPIO816

To install an expander, see the following:
1 Mount the expander. (page 7)
2 Wire the expander for power. (page 8)
3 Address the expander. (page 9)
4 Wire inputs and outputs. (page 9)

For details on individual expanders, see the Automated Logic® expander's Technical Instructions or the Carrier MPC Open XP Installation and Start-up Guide.

To mount an expander

⚠️ WARNING
When you handle the expander:
- Do not contaminate the printed circuit board with fingerprints, moisture, or any foreign material.
- Do not touch components or leads.
- Handle the board by its edges.
- Isolate from high voltage or electrostatic discharge.
- Ensure that you are properly grounded.

Wiring restrictions for connecting the expanders to the Carrier® ChillerVu™
- Maximum length: 100 feet (30 meters)
- 22 or 24 AWG, low-capacitance, twisted, stranded, shielded copper wire

Mount the expanders by the Carrier® ChillerVu™, by screwing the expander into an enclosed panel, using the mounting slots on the coverplate. Leave about 2 in. (5 cm) on each side of the controller for wiring.
To attach expanders

Do not exceed 100 feet total wire length.

1. Wire the controller's Xnet Remote Expansion port to the same port on the expander.
   Connect:
   - Gnd to Gnd
   - Xnet- to Xnet-
   - Xnet+ to Xnet+

   **NOTE** To use more than one expander, wire their Xnet Remote Expansion ports together in a daisy-chain configuration. The Carrier® ChillerVu™ must be the first device on the expander network.

2. You must set the Xnet baud rate to 500 kbps in the WebCTRL® interface on the driver's Xnet page. See [To set up the driver](page 35).

3. If the expander network has more than one expander, place the Term jumper in the down position or remove it from all expanders except the one at the end of the expander network. The Term jumper must be in the up position on the expander at the end of the network.

To wire the expander for power

**CAUTIONS**

- The expanders are powered by a Class 2 power source. Take appropriate isolation measures when mounting it in a control panel where non-Class 2 circuits are present.
- For the Carrier® ChillerVu™ to recognize an attached expander, you must turn on the expander before you turn on the Carrier® ChillerVu™.

1. Verify that the expander's power switch is in the Off position.

2. Connect the 24 Vac power source to the 24 Vac/26 Vdc and Ground terminals, being sure to maintain proper polarity if power is being shared.

3. Turn on the expander's power switch.

4. Verify that the expander's Power LED is on and the Run LED is blinking.
To set the expander's address

You must give the expanders an address that is unique on the expander network.

1. If wired for power, turn off the expander's power and the attached controller's power.
2. Set the expander's address on the rotary switch.

   **EXAMPLE** If the controller's address is 2, point the arrow on the switch to 2.

   ![Rotary Switch Example]

   **NOTE** The Carrier® ChillerVu™ can have a maximum of 6 expanders. You MUST address the expanders as 1 through 6. Higher addresses will not work.

3. Turn on the expander's power and then turn on the attached controller's power. The controller reads the powered expander's address each time you turn on the controller.

**CAUTION** The first time the controller communicates with an expander, it triggers a software download. This may occur if the expander(s) are blank (not a normal condition) and in cases where the controller’s driver has been updated. During that time, the red Error LED and the green Run LED on the expander(s) flash in sequence. This process may take several minutes to complete. Do not disconnect power or communications wiring during this download.

To wire inputs and outputs

The following applies to the inputs and outputs on the Automated Logic® and Carrier expanders.

1. Verify that the Carrier® ChillerVu™’s power and communications connections work properly.
2. Turn off the Carrier® ChillerVu™’s power.
3. Connect the input wiring to the screw terminals on the expander. See figure below.

   **NOTES**
   - Connect the shield wire to the GND terminal with the ground wire.
   - For a loop-powered 4-20 mA sensor, wire the sensor's positive terminal to the + terminal on the Carrier® ChillerVu™’s Aux Power Out connector. Wire the sensor's negative terminal to an input's + terminal.
4 Set each input’s Universal Input Mode Select jumper to indicate the type of input.

5 Connect digital and analog output wiring to the UO screw terminals on the expander and to the controlled device. Connect the ground wire to the UO’s Gnd terminal.

**WARNING!** Binary outputs are powered, 24 Vdc channels. Dry contact binary outputs are not supported. Do NOT apply 24 Vac to these universal outputs.
6 Set each output's jumper to the type of device wired to the output.

7 For each digital output, turn the output's potentiometer clockwise until it stops (maximum output).

8 Turn on the Carrier® ChillerVu™'s power.
Addressing the Carrier® ChillerVu™

The Carrier® ChillerVu™ needs two addresses, one for the controller network and one for the Ethernet.

<table>
<thead>
<tr>
<th>The Carrier® ChillerVu™ needs...</th>
<th>That Is unique on the...</th>
<th>Notes</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A MAC address</td>
<td>controller network</td>
<td>You set the MAC address on the controller's rotary switches.</td>
<td>To set the controller network MAC address (page 12)</td>
</tr>
<tr>
<td>An IP address</td>
<td>Ethernet</td>
<td>You can use one of the following:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The default IP address that your system creates:</td>
<td>To use a default IP address (page 13)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o IP address = 192.168.168.x where x is the controller network MAC address.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Subnet mask = 255.255.255.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• A DHCP IP address</td>
<td>To use a DHCP IP address (page 13)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Assign a custom IP address</td>
<td>To use a custom IP address (page 14)</td>
</tr>
</tbody>
</table>

NOTES

• Carefully plan your addressing scheme to avoid duplicating addresses. If third-party devices are integrated into the system, make sure your addresses do not conflict with their addresses.
• The controller network MAC address and IP address are defined in SiteBuilder in the controller's properties dialog box.
• You can address the Carrier® ChillerVu™ before or after you wire it for power.

To set the controller network MAC address

CAUTIONS

• The MAC address must be unique on the controller network.
• If you are using default IP addressing, the MAC address must match the last octet of the Address field in the controller's properties dialog box in SiteBuilder.

1 If wired for power, turn off the controller's power.

2 The controller only reads the rotary switch positions during power up or upon reset.

3 Use the rotary switches to set the address. Set the Tens (10's) switch to the tens digit of the address, and set the Ones (1's) switch to the ones digit.
EXAMPLE If the controller's address is 25, point the arrow on the **Tens (10's)** switch to 2 and the arrow on the **Ones (1's)** switch to 5.

10's 1's

---

**To use a default IP address**

> **CAUTION** The IP address must be unique on the Ethernet.

1 If wired for power, turn off the controller's power.

2 The controller only reads the rotary switch positions during power up or upon reset.

3 Set the **IP Addr** DIP switch to **Assigned (On)**.

4 Use the rotary switches to set the Carrier® ChillerVu™'s address. Set the **Tens (10's)** switch to the tens digit of the address, and set the **Ones (1's)** switch to the ones digit.

   **EXAMPLE** If the controller's address is 25, point the arrow on the **Tens (10's)** switch to 2 and the arrow on the **Ones (1's)** switch to 5.

   10's 1's

5 Set the **+100/0** DIP switch to **On** to add 100 to \( x \) in the IP address.

   **EXAMPLE** If you turn on this DIP switch and the controller network MAC address is 25, the IP address is 192.168.168.125.

6 Connect Port E1, which is the only port that speaks BACnet over IP.

The default address is an intranet address. Data packets from this address are not routable to the Internet.

---

**To obtain an IP address using DHCP**

1 Turn the Carrier® ChillerVu™'s power off.

2 Check the communications wiring for shorts and grounds.

3 Set the **IP Addr** DIP switch to **DHCP (Off)**.

4 Set the **Enhanced Access Port** DIP switch to **Off**.

5 Connect Port E1, which is the only port that speaks BACnet over IP.

6 Turn the Carrier® ChillerVu™'s power on. The DHCP server assigns an IP address to the Carrier® ChillerVu™.

7 Set a unique Device Instance number using a touchscreen device, Hyperterminal, or PuTTY (page 25).

8 Turn the controller's power off, then on again.
To assign a custom IP address

1. Obtain the IP address, subnet mask, and default gateway address for the controller from the facility network administrator.
2. Set the Carrier® ChillerVu™'s Enhanced Access DIP switch to ON.
3. Set the Assigned/DHCP DIP switch to Assigned.
4. Turn off the controller's power.
5. Connect a laptop with the WebCTRL® Server to the Carrier® ChillerVu™'s Local Access port. See To communicate through the local access port (page 41).
6. In SiteBuilder, set your Configure > Preferences > Connections tab settings.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>The computer's port number that the USB cable is connected to.</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>115200</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

7. On the Network tree, double-click the controller.
8. On the Address tab, select Specify a custom or DHCP IP Address.
9. Type the IP Address, Subnet Mask, and Default Gateway Address.
10. Click Download Address.
11. When the download is complete, click Module Status in the same dialog box to verify the controller's address.
12. When finished, set the Carrier® ChillerVu™'s Enhanced Access DIP switch to OFF to restore normal functionality to the Local Access port.
13. Turn on the controller's power.
## Wiring for communications

The Carrier® ChillerVu™ communicates using BACnet and/or third-party protocols, and can connect to a variety of port types at multiple baud rates. See table below.

<table>
<thead>
<tr>
<th>Port</th>
<th>Protocol</th>
<th>Port type(s)</th>
<th>Baud rate(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ethernet</strong></td>
<td><strong>Port E1</strong></td>
<td>Ethernet</td>
<td>10 Mbps</td>
</tr>
<tr>
<td></td>
<td>BACnet/IP</td>
<td></td>
<td>100 Mbps</td>
</tr>
<tr>
<td></td>
<td>BACnet/Ethernet</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Modbus/IP</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Telnet Diagnostics</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
<td>All protocols can run simultaneously.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>BACnet</strong></td>
<td>BACnet ARC156</td>
<td>EIA-485 (2-wire)</td>
<td>156 kbps</td>
</tr>
<tr>
<td><strong>S1</strong></td>
<td>CCN</td>
<td>EIA-485 (2-wire)</td>
<td>9600 bps</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>19.2 kbps</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>38.4 kbps</td>
</tr>
<tr>
<td><strong>S2</strong></td>
<td><strong>BAConet MS/TP</strong></td>
<td>EIA-485 (2-wire)</td>
<td>9600 bps</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>19.2 kbps</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>38.4 kbps</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>76.8 kbps (default)</td>
</tr>
<tr>
<td><strong>Modbus</strong></td>
<td></td>
<td>EIA-232</td>
<td>Various</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EIA-485 (2-wire)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>EIA-485 (4-wire)</td>
<td></td>
</tr>
<tr>
<td><strong>LonWorks</strong></td>
<td>Lonworks Explicit</td>
<td>5-pin Port S2 to connect LonWorks SLTA-10</td>
<td>57.6 kbps</td>
</tr>
<tr>
<td><strong>Local Access</strong></td>
<td>Enhanced Access</td>
<td>Rnet²</td>
<td>115.2 kbps</td>
</tr>
</tbody>
</table>

¹ Port S2 supports only one protocol and one wire type at a time.

² See Wiring devices to the Carrier® ChillerVu™'s Rnet port (page 27).

---

## Ethernet, BACnet MS/TP, ARC156, and CCN wiring specifications

<table>
<thead>
<tr>
<th>For...</th>
<th>Use...</th>
<th>Maximum Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet</td>
<td>CAT5e or higher Ethernet cable</td>
<td>328 feet (100 meters)</td>
</tr>
<tr>
<td>BACnet MS/TP*</td>
<td>22 or 24 AWG, low-capacitance, twisted, stranded, shielded copper wire</td>
<td>2000 feet (610 meters)</td>
</tr>
</tbody>
</table>
For... | Use... | Maximum Length
---|---|---
CCN | • 3-conductor  
• 18 or 20 AWG stranded tinned copper wire  
• Polyethylene insulation, PVC jacket  
• Shielded with a drain wire  
• Belden wire P#8772 or similar | 1000 feet (305 meters)

NOTE Must meet the above requirements

*For details see the Open Controller Network Wiring Guide.

WARNING Do not apply line voltage (mains voltage) to the controller’s ports and terminals.

To wire to a BACnet/ARC156 network

1. Turn off the Carrier® ChillerVu™'s power.
2. Check the communications wiring for shorts and grounds.
3. Connect the communications wiring to the controller’s screw terminals labeled Net +, Net -, and Shield.
   
   NOTE Use the same polarity throughout the network segment.
4. If the Carrier® ChillerVu™ is at either end of a network segment, connect a BT485 to the Carrier® ChillerVu™.
5. Turn on the Carrier® ChillerVu™'s power.
6. Verify communication with the network by viewing a Module Status report in the WebCTRL® interface.

Ethernet and BACnet MS/TP wiring specifications

<table>
<thead>
<tr>
<th>For...</th>
<th>Use...</th>
<th>Maximum Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet</td>
<td>CAT5e or higher Ethernet cable</td>
<td>328 feet (100 meters)</td>
</tr>
<tr>
<td>MS/TP</td>
<td>22 AWG, low-capacitance, twisted, stranded, shielded copper wire</td>
<td>2000 feet (610 meters) per segment</td>
</tr>
</tbody>
</table>

WARNING Do not apply line voltage (mains voltage) to the controller's ports and terminals.
To wire to a BACnet MS/TP network

The Carrier® ChillerVu™ communicates using BACnet on an MS/TP network segment communications at 9600 bps, 19.2 kbps, 38.4 kbps, or 76.8 kbps.

Wire the controllers on an MS/TP network segment in a daisy-chain configuration.

Install a BT485 on the first and last controller on a network segment to add bias and prevent signal distortions due to echoing.

See the MS/TP Networking and Wiring Installation Guide for more details.

1. Turn off the Carrier® ChillerVu™'s power.
2. Check the communications wiring for shorts and grounds.
3. Connect the communications wiring to the controller’s screw terminals labeled Net+ and Net- on Port S2.
   
   **NOTE** Use the same polarity throughout the network segment.
4. Set the Port S2 MS/TP DIP switch to Enable (ON).
5. If the Carrier® ChillerVu™ is at either end of a network segment, connect a BT485 to the Carrier® ChillerVu™.
6. Turn on the Carrier® ChillerVu™'s power.
7. To change the port's baud rate, see To set a port's baud rate using PuTTY (page 25).
   
   **NOTE** Use the same baud rate for all controllers on the network segment.
To connect the Carrier® ChillerVu™ to the Ethernet

Connect an Ethernet cable to the Ethernet port.

**NOTE** If your system has controllers on different IP subnets separated by an IP router, you must configure one controller on each subnet as a BACnet Broadcast Management Device (BBMD). Do not configure more than one BBMD per subnet as this would cause circular routes. To avoid this problem:

- Let SiteBuilder automatically configure your BBMD tables. (SiteBuilder defines only one controller per IP subnet as a BBMD.)
- Use the BBMD Configuration Tool to make sure that a controller's BBMD table does not contain the IP addresses of other controllers on the same IP subnet.

To wire to a BACnet over Ethernet network

1. Turn off the power for the Carrier® ChillerVu™ by disconnecting power terminals.
   **NOTE** The controller reads the address each time you turn it on.
2. Connect Port E1, which is the only port that speaks BACnet over Ethernet.
3. Turn on the power for the Carrier® ChillerVu™ by connecting power terminals.
4. See Addressing the Carrier® ChillerVu™ (page 12) for details on setting the IP address. You can use PuTTY (page 25) or a touchscreen device.
5. Use a Modstat to find your Ethernet hexadecimal address and enter that in SiteBuilder.

To wire to the BACnet over IP network (DHCP)

1. Turn off the Carrier® ChillerVu™s power.
2. Check the communications wiring for shorts and grounds.
3. Set the Assigned/DHCP DIP switch to the DHCP position.
4. Set the +100/0 DIP switch to On to add 100 to x in the IP address.
   **EXAMPLE** If you turn on this DIP switch and the MAC address is 25, the IP address is 192.168.168.125.
   **NOTE** The DHCP address is an intranet address. Data packets from this address are not routable to the Internet.
5. Verify DIP switch 1 is set to Off.
6. Connect Port E1, which is the only port that speaks BACnet over IP.
7. Turn on the Carrier® ChillerVu™s power.
8. Set a unique Device Instance number using a touchscreen device or PuTTY (page 25).
To wire to a BACnet over IP network (assign a custom IP)

1. Turn off the Carrier® ChillerVu™'s power.

2. Using the rotary switches, set the Carrier® ChillerVu™'s address. Set the Tens (10's) switch to the tens digit of the address, and set the Ones (1's) switch to the ones digit.

   EXAMPLE If the controller’s address is 25, point the arrow on the Tens (10's) switch to 2 and the arrow on the Ones (1's) switch to 5.

3. Obtain the IP address, subnet mask, and default gateway address for the controller from the facility network administrator.

4. Set the Assigned/DHCP DIP switch to the Assigned position.

5. Set the +100/0 DIP switch to On to add 100 to x in the IP address.

   EXAMPLE If you turn on this DIP switch and the MAC address is 25, the IP address is 192.168.168.125.

   NOTE The DHCP address is an intranet address. Data packets from this address are not routable to the Internet.

6. Set the following using a touchscreen device or PuTTY (page 25).
   ○ IP address
   ○ A unique Device Instance number

7. Connect Port E1, which is the only port that speaks BACnet over IP.

   Wiring Specifications
   ○ 328 feet (100 meters)
   ○ Use one of the following CAT5 or higher Ethernet cables:
     ▪ A cross-over cable to connect the Carrier® ChillerVu™ directly to the third-party device
     ▪ A straight-through cable to connect the Carrier® ChillerVu™ to a hub or switch, and a second straight-through cable to connect the hub or switch to the third-party device

   NOTE Use the same polarity throughout the network segment.

8. Turn on the Carrier® ChillerVu™'s power.
To wire to a CCN network

1. Turn off the Carrier® ChillerVu™'s power.
2. Check the communications wiring for shorts and grounds.
3. Verify that the Port S1 485/232 jumper is set to EIA-485 (left side) and the 2/4 jumper to 485-2W (right side).
4. Connect the Carrier® ChillerVu™'s Port S1 to the CCN bus. Use the same polarity throughout the network segment.

<table>
<thead>
<tr>
<th>Wire this Port S1 terminal</th>
<th>To this CCN device terminal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal Ground (Pin 5)</td>
<td>G</td>
</tr>
<tr>
<td>Net- (Pin 2)</td>
<td>-</td>
</tr>
<tr>
<td>Net+ (Pin 1)</td>
<td>+</td>
</tr>
</tbody>
</table>

**NOTE** The CCN Shield should be tied/taped back or daisy chained if the Carrier® ChillerVu™ is not at one end of the bus.

5. Turn on the Carrier® ChillerVu™'s power.

Commission the Carrier® ChillerVu™ using Network Service Tool

1. Use Network Service Tool V (NST V) to connect the Carrier® ChillerVu™ directly into Port S1, which is designated for CCN communications.
2. Upload the Carrier® ChillerVu™ (Default CCN Address 0, 1).
3. Access the Service Configuration Table IP_CONF to enter the following configuration options:

**NOTE** A static IP address is required, as DHCP is not supported.

- **Host IP Address** - enter the device manager's IP address, provided by the LAN administrator (allowable entries for xxx.xxx.xxx.xxx: xxx is a decimal number between 0 - 255)
- **Subnet Mask** - enter the device manager's IP address, provided by the LAN administrator (allowable entries for xxx.xxx.xxx.xxx: xxx is a decimal number between 0 - 255)
- **Default Gateway** - enter the IP Gateway's IP address, provided by the LAN administrator (typically a router on the Ethernet LAN).

**CCN ENET Configuration**

**Device Type** -

- Select **Gateway** if the converter connects the primary CCN Bus (Bus 0) to the Ethernet, and toggle the spacebar to select 0.
- Select **Bridge** if the converter connects a secondary CCN Bus to the Ethernet and toggle the spacebar to select 1.

**NOTE** You can only have one Gateway per system.
If configured as a Bridge:

- **CCN/Ethernet Gateway Address** - enter the IP address of the i-Vu® device manager that is configured as the CCN Ethernet Gateway. This is the same address that was entered in the Host IP address for the CCN Gateway. (Entries are allowed for xxx.xxx.xxx.xxx are decimal numbers between 0 - 255.)

**NOTE** When the device manager is configured as the Gateway, it ignores the CCN/Ethernet Gateway IP address. In this case, leave the CCN/Ethernet gateway address at its default setting (0.0.0.0.).
### Wiring for third party protocols

You can connect third party protocols after you set up BACnet. The drv_psm for the Carrier® ChillerVu™ allows access to the following third party protocols. Additional drivers are not required.

You can use this combination of protocols or a subset of them:

BACnet port (ARC156 only) AND Port S1 (CCN only) AND Port S2 (1 of 3 protocols) AND Port E1 (all 4 protocols or any combination of them)

<table>
<thead>
<tr>
<th>Port</th>
<th>Protocol(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>BACnet</td>
<td>BACnet ARC156</td>
</tr>
<tr>
<td>Port S1</td>
<td>CCN</td>
</tr>
<tr>
<td>Port S2</td>
<td>1 of the following 3 protocols - DIP switch selectable (TPI or MS/TP)</td>
</tr>
<tr>
<td></td>
<td>• BACnet MS/TP</td>
</tr>
<tr>
<td></td>
<td>• Modbus RTU</td>
</tr>
<tr>
<td></td>
<td>• LonWorks via SLTA</td>
</tr>
<tr>
<td>Port E1</td>
<td>All or any combination of the following:</td>
</tr>
<tr>
<td></td>
<td>• BACnet/IP</td>
</tr>
<tr>
<td></td>
<td>• BACnet/Ethernet</td>
</tr>
<tr>
<td></td>
<td>• Modbus/IP</td>
</tr>
<tr>
<td></td>
<td>• CCN/IP</td>
</tr>
</tbody>
</table>

### To wire to Modbus RTU on Port S2

**NOTE** You can use Port S2 for Modbus RTU or Lon SLTA-10, but not at the same time.

1. Turn off the Carrier® ChillerVu™'s power.
2. Set DIP switch 5 to **TPI**.
3. Set jumpers to **EIA-485** and **Half Duplex**.
4. Connect the communications wiring to Port S2. Connect to **Net+**, **Net-**, and **Gnd**.

#### Wiring specifications

- A dedicated 24 AWG to 18 AWG twisted pair wire (EIA-485)
- 2000 feet (610 meters) for 76.8 kbps
- 3000 feet (914.4 meters) for 9600 bps, 19.2 or 38.4 kbps, before needing a Repeater
- Devices should be daisy chained and not star wired
- If the Carrier® ChillerVu™ is at either end of a network segment, connect a BT485 to the Carrier® ChillerVu™

**NOTE** Use the same polarity throughout the network segment.
In the WebCTRL® interface, go to **Driver Properties > Protocols > Modbus** and enter the baud rate.

Turn on the Carrier® ChillerVu™'s power.

### To wire to a Modbus over IP network

1. Turn **off** the Carrier® ChillerVu™'s power.
2. Check the communications wiring for shorts and grounds.
3. Connect Port E1 to the third-party device.
   - **NOTE** Port E1 will still be capable of BACnet communication.
   
   **Wiring Specifications**
   - 328 feet (100 meters)
   - Use one of the following CAT5 or higher Ethernet cables:
     - A cross-over cable to connect the Carrier® ChillerVu™ directly to the third-party device
     - A straight-through cable to connect the Carrier® ChillerVu™ to a hub or switch, and a second straight-through cable to connect the hub or switch to the third-party device

   - **NOTE** Use the same polarity throughout the network segment.

4. Turn on the Carrier® ChillerVu™'s power.

### To connect to the LonWorks network using the SLTA-10

1. Turn **off** the Carrier® ChillerVu™'s power.
2. Set DIP switch 4 to **TPI**.
3. Set the Port S2 jumper to EIA-232.
4. Connect the communications wiring to Port S2.
Wire Specifications

- 18–28 AWG; twisted pair preferable
- 50 feet (15.24 meters) maximum length

**NOTE** Do not power the device from the same transformer that powers the Carrier® ChillerVu™.

5. Set the SLTA-10 DIP switches as shown below.

**NOTE** Switches 6 - 8 set the baud rate to 57600 for communication between the controller and the SLTA-10.

6. In the WebCTRL® interface, right-click the Carrier® ChillerVu™ in the navigation tree, select **Driver Properties** > **Protocols** > **LonWorks**, and set the baud rate to 57600.

7. Turn **on** the Carrier® ChillerVu™'s power.

---

**To wire a third-party device**

See the Integration Guide for the third-party device or protocol.
## To set a port's baud rate using PuTTY

1. Download and install PuTTY from the PuTTY website (http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html).

2. Connect a computer to the Carrier® ChillerVu™'s Local Access port. See To communicate through the local access port (page 41).

3. Set the Carrier® ChillerVu™'s Enhanced Access DIP switch to ON.

4. Turn the Carrier® ChillerVu™'s power Off, then On.

5. Start PuTTY.

6. Under **Category** > **Connection**, select **Serial**.

7. Under **Options controlling local serial lines**, enter the following settings:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial line to connect to</td>
<td>Replace X with the computer's port number that the USB Link Kit cable is connected to.</td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
<td>To find the port number, select <strong>Start</strong> &gt; <strong>Control Panel</strong> &gt; <strong>System</strong> &gt; <strong>Device Manager</strong> &gt; <strong>Ports (Com &amp; LPT)</strong>. The COM port number is beside Silicon Labs CP210x USB to UART Bridge.</td>
</tr>
<tr>
<td>Speed (baud)</td>
<td>115200</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Flow Control</td>
<td>None</td>
</tr>
</tbody>
</table>
8 Click **Open**. A window similar to the one below appears.

```plaintext
BACnet Router, Ethernet MAC address = 00-E0-C9-00-4E-B8
1) Restart
2) Display Modstat
3) IP Address [192.168.168.11]
4) Subnet Mask [255.255.255.01]
5) Default Gateway [0.0.0.01]
6) BACnet/IP UDP Port [8x0AC0]
7) BACnet/IP Network [4824+1]
8) BACnet/Ethernet Network [4829]
9) BACnet/IPCHN Network [4825]
10) BACnet/MSTP Network [4834]
11) Display B/IP PAD Table
12) Add B/IP PAD Table Entry
13) Delete B/IP PAD Table Entry
14) Clear B/IP PAD Table
15) Set baud rate for MSTP [76800]
16) Set baud rate for PTP [38400]

* The HOME network is updated each time a network number is changed (#7-10).

Enter selection: _
```

9 Type the number of the baud rate field, then press **Enter**.

10 Type the new baud rate, then press **Enter**.

11 Type 1, then press **Enter** to restart the controller.

12 When finished, set the Carrier® ChillerVu™s **Enhanced Access** DIP switch to **OFF** to restore normal functionality to the **Local Access** port.

13 Turn the Carrier® ChillerVu™s power **Off**, then **On**.
Wiring devices to the Carrier® ChillerVu™'s Rnet port

The standard control programs that are included with the Carrier® ChillerVu™ library do not use communicating sensors or the Equipment Touch.

A custom control program could allow you to use and connect the following to the Rnet port:

- Up to 15 ZS sensors (5 per control program)
- One Wireless Adapter that communicates with up to 15 wireless sensors
- One Equipment Touch
- Up to 4 SPT Standard sensors and one SPT Plus, SPT Pro, or SPT Pro-F sensor

**NOTE** ZS sensors, a Wireless Adapter, and an Equipment Touch can share the Rnet, but not SPT sensors.

To configure the control program for the desired user interaction with the ZS or wireless sensors, see the ZS Sensor Application Guide or the Wireless Sensor Application Guide.

Adding the Carrier® ChillerVu™ into the WebCTRL® system

To prepare to create your system

You must create the control program before building your Carrier® ChillerVu™ system.

The Carrier® ChillerVu™ accepts any of the following:

- Applications from the psm (plant system manager) equipment SAL library
- UC applications from the Universal Controller equipment sal library
- Air Handler applications from the AHU Builder library
- CCN applications from the ivu-6.0 or 6.5-discovery library
- User-created EIKON® programs

  **NOTE** These applications will not load into any controller except the Carrier® ChillerVu™ controller.

When creating your program in the EIKON® interface, you must select **Control Program > PSM, Open (non PIC)**, or **CCN** to be able to download the program into the controller.

The EquipmentBuilder or EIKON® application

1. Use the EquipmentBuilder or EIKON® application to create control program(s) for your Carrier® ChillerVu™.
2. If applicable, print the Sequence of Operation, which includes the points list.

  **NOTE** You can create a points list under **Reports** in the WebCTRL® application.

To create your system in SiteBuilder v6.5

You must complete the following procedures to successfully install your Carrier® ChillerVu™ into the WebCTRL® system. Use the Help in the referenced software for detailed descriptions of these procedures.

1. If you have not created your system yet, open SiteBuilder and select **File > New**. Enter the **System Name**, click **Next**, and click **Next** again.
2. In SiteBuilder, on the **Network** tree, verify that the BACnet/IP network is correct for your system.
3. To the BACnet/IP network, right-click and select **BACnet Device Router**.
   a) Enter the controller’s **Name**.
   b) Change the **Device Definition** to **PSM** to add the driver.
Adding the Carrier® ChillerVu™ into the WebCTRL® system

To scan in and download CCN devices

Set up CCN Information

1. Follow these steps to set the Carrier® ChillerVu™ as the Gateway or Bridge (default).

   **NOTE**
   a) Set the Carrier® ChillerVu™'s Port S2 DIP switch TPI to CCN (Off) and cycle the controller's power.
   b) Right-click the Carrier® ChillerVu™ and select Driver Properties.
   c) Expand Protocols and select CCN.
   d) Select the correct baud rate (default is 9600 bps) from drop-down list.
   e) If it is the Gateway, select CCN Gateway for Device Type. If it is a Bridge, select CCN Bridge.
   f) Change the Element number from the default (1).
   g) Continue with the steps below.

Connect to a CCN system

1. In the WebCTRL® interface, select the system in the navigation tree.

2. On the Devices page > CCN Setup tab, enter your CCN Gateway IP address and click Connect to Gateway.

   **NOTE** If the server has more than 1 NIC, type the IP address the server will use to connect to controllers.

3. After connecting to the Gateway, select it in the navigation tree.

4. On the Devices page > CCN Discovery tab, verify that Discover Tables is checked.

   **NOTE** The scanning time for discovering tables increases based on the number of devices. You may choose to discover tables at a later time for a faster scan.
Adding the Carrier® ChillerVu™ into the WebCTRL® system

5 Enter the Bus and Element ranges that encompass all your devices.
   **NOTE** Depending on your number of devices, it could be faster to scan several small ranges.

6 Click Start Scan. When the process is complete, a message appears showing the number of control programs found.
   **NOTES**
   ○ If the scan does not begin, wait a minute and try again. There may be a delay when first starting the system.
   ○ If an error message appears, click on the message to view an explanation.

7 Click Download CCN to download the control programs, drivers, and parameters.

8 In the WebCTRL® navigation tree, right-click the Carrier® ChillerVu™ and select Driver Properties from the drop-down list.

9 Under Driver, expand Protocols.

10 On the CCN tab, under Broadcast Configuration:
   ○ If the Carrier® ChillerVu™ will be the time broadcaster on the CCN network, check Time Broadcast Enable.
   ○ If there is another CCN device already set as the time broadcaster, check Use CCN Time Sync so the Carrier® ChillerVu™ synchronizes its clock with the CCN network.

11 Click Accept.

**TIPS**
- ![Download CCN icon] indicates you need to download the device by clicking Download CCN.
- Click ![ UWU ] to view a log of activity on the Devices page in the current session. Copy to Clipboard lets you copy the text to paste it into another application.
- Status messages are color coded as follows:
  ○ Red - reports an error
  ○ Blue - requires action
  ○ Green - indicates an upload or download is in process

---

To add control programs and graphics in the WebCTRL® interface

Use the following procedure to add all of the control programs (.equipment files) that you need to run your system.

1 Select the Carrier® ChillerVu™ in the navigation tree.

2 On the Devices > Manage tab, select the Carrier® ChillerVu™ in the list on the page.

3 Click the Add Control Program button. A dialog window appears.

4 Type a Display Name for the control program.

5 Select the Controller that you are adding the program to.
   **NOTE** If you already have the maximum number of control programs for a controller, it will not appear in the list.
Adding the Carrier® ChillerVu™ into the WebCTRL® system

To add the control program, do the following:

<table>
<thead>
<tr>
<th>If the control program is...</th>
<th></th>
</tr>
</thead>
</table>
| In the Control Program drop-down list | 1. Select the control program that you generated in EquipmentBuilder or Snap.  
2. Click **Accept**. |
| Not in the Control Program drop-down list | 1. Click **Add New**.  
2. Browse to select the control program.  
3. Click **Open**.  
4. Click **Continue**.  
5. Click **Close**.  
6. Click **Accept**. |

1. To add a graphic, click **Add New** under Views and browse to your .view file.  
2. Click **Continue**. When message appears **File added successfully**, click **Close**.  
3. Click **Close** again.  
4. Right-click on the controller in the controller list and select **Check Status** from the list. The status of the controller should say **File Mismatch**.  
5. Click the **Download All Content** button.  
6. Configure the controller on the Properties page > Control Program tab.  
7. Check out and commission the equipment.

**To configure third party protocols in the WebCTRL® Interface**

After you download the driver and control program(s) to the Carrier® ChillerVu™, you must configure the protocol properties in the WebCTRL® interface.

**Modbus RTU on Port S2**

1. Verify the Port S2 DIP switch (5) TPI is On and the controller's power has been cycled.  
2. On the WebCTRL® Network tree, click \(\rightarrow\) to the left of your Carrier® ChillerVu™.  
4. Under **Port Configuration**, check **Enable** under Port S2.  
5. Select **EIA-485** for Communication Type.  
6. Enter your Baud rate.  
7. Under **Protocol Configuration**, select the correct option for **Is this device a Master?**.  
8. Accept all other default settings.  
9. Click **Accept**.
Adding the Carrier® ChillerVu™ into the WebCTRL® system

**Modbus over IP network**

1. Verify the Port S2 DIP switch (5) **TPI** is On and the controller's power has been cycled.

2. On the WebCTRL® Network tree, click ➔ to the left of your Carrier® ChillerVu™.

3. Under **Driver**, expand **Protocols > Modbus TCP/IP**.

4. Select **TCP/IP** for **Communication Type**.

5. Under **Modbus Protocol Configuration**:
   - If your Carrier® ChillerVu™ is a client:
     1. Select **Yes** for **This device is a Client**.
     2. Click **Accept**.
     3. In the navigation tree, under **Protocols > Modbus TCP/IP**, go to **IP Index Table** and follow the directions at the bottom of the page to fill in the **Server IP Addresses**.
   - If your Carrier® ChillerVu™ is a server, select **No** for **This device is a Client**.

6. Click **Accept**.

**The LonWorks network using the SLTA-10**

1. Verify the Port S2 DIP switch (5) **TPI** is On and the controller's power has been cycled.

2. On the WebCTRL® Network tree, click ➔ to the left of your Carrier® ChillerVu™.

3. Under **Driver**, expand **Protocols > LonWorks**.

4. Under **Port Configuration**, select **Port S2** for **is connected to the LonWorks network**, then select **SLTA**.

5. Set **Baud** to 57600.
   - **NOTE** This is the baud rate between the LonWorks SLTA-10 and the Carrier® ChillerVu™, not the LonWorks network.

6. Accept all other default settings.

7. Click **Accept**.
To enable the CCN PIC equipment files to communicate with the Chiller Manager program, you must edit the Reference Names in SiteBuilder for the chillers. You must have already completed To scan in and download CCN devices to your WebCTRL® system (page 29).

**Before proceeding, you must have already:**
- Created your WebCTRL® database
- Discovered and downloaded the CCN PICs to the Carrier® ChillerVu™ controller
- Created and added the Chiller Manager control programs to the WebCTRL® database
- Have WebCTRL Server running

1. From the WebCTRL Server interface, click Launch Concurrent SiteBuilder.
2. Type your Name and Password.
3. Click the mode icon to change from View Mode (red) to concurrent Edit Mode (green) and then click Continue.

**NOTES**
- Any changes you make while SiteBuilder is in Edit Mode are saved immediately. You cannot "close" SiteBuilder without saving changes.
- In view only mode, WebCTRL Server and field communications run normally. In edit mode, the WebCTRL Server is not affected, but field communications are disabled and operators will see question marks on WebCTRL® pages instead of live data. After you switch to view mode or close SiteBuilder, field communications resume automatically.

4. In the Geographic tree, right-click on a chiller and select Properties from the drop-down menu.
5. In the Properties dialog > General tab, you must change the Reference Name to #chiller_x, where x is the chiller number.

**EXAMPLE** For a 3-chiller system, the chiller reference names are:
- #chiller_1
- #chiller_2
- #chiller_3

6. Click OK.
7. Repeat steps 4 - 6 for every chiller.
8. When all chillers are renamed, click the mode icon to change to View Mode.
9 Close SiteBuilder.

10 To verify your chiller connections in the WebCTRL® interface, select the Chiller Manager program in the navigation tree and go to the Properties > Network Points tab. If you see any errors on the pre-configured network points, review your Reference Name edits.
To set up the driver

After you download the driver and control program(s) to the Carrier® ChillerVu™, you may want to change the driver's properties in the WebCTRL® interface to suit your application.

1. On the WebCTRL® Network tree, click ▼ to the left of your Carrier® ChillerVu™.
2. Click ▼ to the left of Driver to see its children.
3. Make changes as needed on the Properties page for Driver and any of its children.

Driver

On the Driver page, you can change the following properties:

- Backup battery conservation settings. See table below.
- Module clock synchronization and failure. See table below.
- Network Input microblock communication properties.

### Backup Battery

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn off Internal backup battery after ___ days to conserve battery life (shutoff date/time)</td>
<td>How long backup battery should run after power loss.</td>
</tr>
</tbody>
</table>

**TIP**

Downloading activates the battery backup. To conserve battery life when you know the Carrier® ChillerVu™ will be without power for an extended period after downloading (for example, during shipment):

1. Verify the Archive Valid LED is lit, then set this field to 0.
2. After you install the Carrier® ChillerVu™ and apply power, enter a number greater than 0.

### TouchScreen Control

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TouchScreen Schedule Edit Enable</td>
<td>Check this field to allow a user to edit this controller's schedules from an Equipment Touch's Schedules screen.</td>
</tr>
</tbody>
</table>

### Module Clock

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clock Fail Date and Time</td>
<td>Date and time the control program uses when controller's real-time clock is invalid.</td>
</tr>
</tbody>
</table>

**TIP**

Use an occupied date and time (such as a Tuesday at 10 a.m.) so the equipment does not operate in unoccupied mode if the controller loses power during occupancy.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Synch Sensitivity (seconds)</td>
<td>When the controller receives a time sync request, if the difference between the controller's time and the time sync's time is greater than this field's value, the controller's time is immediately changed. If the difference is less than this field's value, the controller's time is slowly adjusted until the time is correct.</td>
</tr>
</tbody>
</table>

### Network Microblocks
To set up the driver

<table>
<thead>
<tr>
<th>Number of poll retries before Network Input Microblocks Indicate failure</th>
<th>The maximum number of retries after the initial attempt that a Network microblock will attempt to communicate with its target device. If unsuccessful, the point will transition to an idle state for 30 seconds before attempting to communicate again. Change this field only if directed by Technical Support.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Periodic rebinding interval</td>
<td>If a microblock uses a wildcard in its address, this timer determines how often the microblock will attempt to find the nearest instance of its target. For example, if an outside air temperature address uses a wildcard, a VAV application will look for the outside air temperature on the same network segment or on the nearest device containing that object.</td>
</tr>
<tr>
<td>BACnet COV Throttling</td>
<td>Under normal circumstances, COV Throttling should be enabled to prevent excessive network traffic if an object's COV Increment is set too low. See EXCEPTION below. When enabled, if an object generates excessive COV broadcasts (5 updates in 3 seconds), the driver automatically throttles the broadcasts to 1 per second. Also, if the object's value updates excessively for 30 seconds, an alarm is sent to the WebCTRL® application listing all objects that are updating excessively. A Return-to-normal alarm is sent only after all objects have stopped updating excessively. EXCEPTION: In rare circumstances, such as process control, a subscribing object may require COV updates more frequently than once per second. For these situations, clear this checkbox, but make sure that your network can support the increased traffic. You will also need to disable the Excessive COV alarms under the driver's Common Alarms.</td>
</tr>
<tr>
<td>Trend Sampling</td>
<td>For values that change infrequently, select to verify at midnight daily that the point is still able to communicate trend values.</td>
</tr>
</tbody>
</table>

**Device**

On the **Device** page, you can change the following properties:

- BACnet device object properties for the Carrier® ChillerVu™
- Carrier® ChillerVu™ communication

<table>
<thead>
<tr>
<th>Configuration</th>
<th>NOTE The three APDU fields refer to all networks over which the Carrier® ChillerVu™ communicates.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Masters and Max Info Frames</td>
<td>Apply only if the Carrier® ChillerVu™s MS/TP network is enabled.</td>
</tr>
</tbody>
</table>
Notification Classes

Alarms in the WebCTRL® application use Notification Class #1. A BACnet alarm’s Notification Class defines:
- Alarm priority for Alarm, Fault, and Return to Normal states
- Options for BACnet alarm acknowledgment
- Where alarms should be sent (recipients)

### Priorities

<table>
<thead>
<tr>
<th>Priority range</th>
<th>Network message priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>00–63</td>
<td>Life Safety</td>
</tr>
<tr>
<td>64–127</td>
<td>Critical Equipment</td>
</tr>
<tr>
<td>128–191</td>
<td>Urgent</td>
</tr>
<tr>
<td>192–255</td>
<td>Normal</td>
</tr>
</tbody>
</table>

**NOTE** BACnet defines the following Network message priorities for Alarms and Events.

- **Priority of Off-Normal**: BACnet priority for Alarms.
- **Priority of Fault**: BACnet priority for Fault messages.
- **Priority of Normal**: BACnet priority for Return-to-normal messages.

**Ack Required for Off-Normal, Fault, and Normal**

Specifies whether alarms associated with this Notification Class require a BACnet Acknowledgment for Off-Normal, Fault, or Normal alarms.

💡 **TIP** You can require operator acknowledgment for an Alarm or Return-to-normal message (stored in the WebCTRL® database). In the WebCTRL® interface on the Alarm > Enable/Disable tab, change the acknowledgment settings for an alarm source or an alarm category.

### Recipient List

<table>
<thead>
<tr>
<th>Recipients</th>
<th>The first row in this list is the WebCTRL® application. Do not delete this row. Click Add if you want other BACnet devices to receive alarms associated with this Notification Class.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recipient Description</td>
<td>Name that appears in the Recipients table.</td>
</tr>
</tbody>
</table>
| Recipient Type | Use Address (static binding) for either of the following:  
- Third-party BACnet device recipients that do not support dynamic binding  
- When you want alarms to be broadcast (you must uncheck Issue Confirmed Notifications). This use is rare. |
| Days and times | The days and times during which the recipient will receive alarms. |
| Recipient Device Object Identifier | Type the Device Instance from SiteBuilder (or from the network administrator for third-party devices) in the # field. |
| Process Identifier | Change for third-party devices that use a BACnet Process Identifier other than 1. The WebCTRL® application processes alarms for any 32-bit Process Identifier. |
| Issue Confirmed Notifications | Select to have a device continue sending an alarm message until it receives delivery confirmation from the recipient. |
| Transitions to Send | Uncheck the types of alarms you do not want the recipient to get. |
Calendars

Calendars are provided in the driver for BACnet compatibility only. Instead, use the Schedules feature in the WebCTRL® interface.

Common and Specific Alarms

On these pages, you can enable/disable, change BACnet alarm properties, or set delays for the following BACnet alarms:

**Common alarms:**
- Module Halted
- All Programs Stopped
- Duplicate Address
- Locked I/O
- Control Program
- Program Stopped
- Excessive COV

**Specific alarm:**
- Dead Module Timeout
- Low Battery Alarm

**NOTE** To set up alarm actions for controller generated alarms, see “Setting up alarm actions” in WebCTRL® Help.

<table>
<thead>
<tr>
<th>Module Generated Alarm</th>
<th>Description</th>
<th>Short message shown on the Alarms page or in an alarm action when this type of alarm is generated.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Events</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm Category and Alarm Template</td>
<td>See &quot;Customizing alarms&quot; in WebCTRL® Help.</td>
<td></td>
</tr>
<tr>
<td>Enable</td>
<td></td>
<td>Clear these checkboxes to disable Alarm or Return to normal messages of this type from this controller.</td>
</tr>
<tr>
<td>Notification Class</td>
<td></td>
<td>Do not change this field.</td>
</tr>
</tbody>
</table>

Custom Translation Tables

You can set up a translation table that an analog input will use to translate the raw data from a non-linear sensor to the engineering units you want it to output on the wire. In the Network tree, select Custom Translation Table #1, #2, or #3. The Properties page has instructions. For the input to use the translation table, navigate to the input in the Geographic tree, select the Details tab, then set Sensor Type (Scaling Method) to Non-Linear, Custom Table #__.
**BACnet router properties**

On the BACnet router properties page, you can change the following properties:
- IP address of the router in the controller and the system database
- BACnet routing settings
- Color and prime variable caching settings

<table>
<thead>
<tr>
<th>IP Configuration</th>
<th>For future use.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow remote management of IP configuration</td>
<td></td>
</tr>
<tr>
<td>Enable IP configuration changeover</td>
<td>Select to remotely change the router's <strong>IP Address</strong>, <strong>Subnet Mask</strong>, and <strong>Default Gateway Address</strong>.</td>
</tr>
<tr>
<td></td>
<td>Type the new addresses and the <strong>UDP Port</strong> that your server is using to communicate to all controllers.</td>
</tr>
<tr>
<td></td>
<td>In the <strong>Changeover timeout</strong> field, enter:</td>
</tr>
<tr>
<td></td>
<td>• 0:00 to have the controller use the <strong>Next</strong> settings as soon as the controller can communicate with the <strong>Next Default Gateway Address</strong>.</td>
</tr>
<tr>
<td></td>
<td>• A specific length of time to have the controller use the <strong>Next</strong> settings as soon as the controller can communicate with the <strong>Next Default Gateway Address</strong>, or when the timeout expires, whichever occurs first.</td>
</tr>
<tr>
<td></td>
<td>See &quot;To remotely change a controller's IP address&quot; in WebCTRL® Help for more information on using this feature.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BACnet Router Options</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore all Reject-Message-to-Network, Reason=1 messages</td>
<td>Clear to delete and rediscover a router if a network's router indicates that the network is no longer present (reason=1).</td>
</tr>
<tr>
<td></td>
<td>Select to continue routing messages to a network even if its router indicates that the network is no longer present.</td>
</tr>
</tbody>
</table>

| Color/Prime Variable Caching                          | Clear (enable) to improve responsiveness in retrieving colors. |
|                                                        | Select (disable):                                        |
|                                                        | • To reduce network traffic to third-party (non-color-supporting) devices |
|                                                        | • If using the Carrier® ChillerVu™ on the controller network, not as a router |
|                                                        | **NOTE** Selecting this checkbox also disables dead module alarms. |

| Dead Module Timeout                                   | After this period (minutes:seconds) of non-response from a controller, the router sends an alarm to the server. |
BACnet firewall

Requires v6-02 or later driver

If this IP controller is accessible from the Internet, you can increase security by enabling its BACnet firewall. When enabled, this feature prevents the controller from receiving BACnet messages from unidentified sources and allows communication only with IP addresses that you define. These can be all private IP addresses and/or a list of IP addresses. Follow the instructions in the WebCTRL® interface to set up the BACnet firewall.

Protocols

On the Protocols page, you can enable or disable Telnet diagnostics. This allows you to write to a text file the communication between the controller and a third party device. This file is used for troubleshooting.

Xnet

If the Carrier® ChillerVu™ has MPC Open XPIO or MEx expanders attached, you can change the baud rate and communications timeout on the Xnet page.

<table>
<thead>
<tr>
<th>Xnet Configuration</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Rate</td>
<td>Set at 500 kbps.</td>
</tr>
<tr>
<td>Comm. Timeout (seconds)</td>
<td>If the expander does not receive communication from the controller for this amount of time, the expander will reset itself. The range is 15–300 seconds.</td>
</tr>
</tbody>
</table>
Communicating through the Local Access port with a USB Link

Using a computer and a USB Link, you can communicate locally with the Carrier® ChillerVu™ to download or to troubleshoot.

**CAUTIONS**

- Maintain polarity when controllers share power.
- Failure to maintain polarity while using the USB Link on a computer that is grounded via its AC adapter may damage the USB Link and the controller.
- If multiple controllers share power but polarity was not maintained when they were wired, the difference between the controller's ground and the computer's AC power ground could damage the USB Link and the controller. If you are not sure of the wiring polarity, use a USB isolator between the computer and the USB Link. Purchase a USB isolator online from a third-party manufacturer. Plug the isolator into your computer's USB port, and then plug the USB Link cable into the isolator.

**PREREQUISITES**

- For the WebCTRL® application to communicate with the controller, the controller must have been downloaded with at least its driver.
- Laptop with USB port
- USB Link (Part #USB-L)

**Using a USB Link**

1. The USB Link driver is installed with an WebCTRL® v5 or later system. But if needed, you can get the latest driver from [http://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx](http://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx). Install the driver before you connect the USB Link to your computer.

2. Connect the laptop to the Local Access port of the controller using the USB Link cable(s).

**NOTE** If using a USB isolator, plug the isolator into your computer's USB port, and then plug the USB Link cable into the isolator.
3. Set the controller's Enhanced Access DIP switch.

<table>
<thead>
<tr>
<th>To communicate in...</th>
<th>Set switch to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The WebCTRL® application</td>
<td>Off</td>
</tr>
<tr>
<td>PuTTY or HyperTerminal</td>
<td>On</td>
</tr>
<tr>
<td>SiteBuilder to set a custom IP address</td>
<td>On</td>
</tr>
</tbody>
</table>

4. Turn the controller's power off, then on again.

**To communicate using PuTTY**

You can connect a computer to a controller's Local Access port and use PuTTY, a free open source terminal emulation program, to:

- Set controller properties, such as IP address and network information
- Retrieve a Modstat

**PREREQUISITES**

- A computer with a USB port
- A USB Link cable

**NOTE** The USB Link driver is installed with a WebCTRL® v5 or later system. But if needed, you can get the latest driver from [http://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx](http://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx). Install the driver before you connect the USB Link to your computer.

**CAUTION** If multiple controllers share power but polarity was not maintained when they were wired, the difference between the controller's ground and the computer's AC power ground could damage the USB Link and the controller. If you are not sure of the wiring polarity, use a USB isolator between the computer and the USB Link. Purchase a USB isolator online from a third-party manufacturer.

**Using PuTTY**

1. Download and install PuTTY from the PuTTY website ([http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html](http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html)).

2. Connect the laptop to the local access port of the controller or ZS sensor using the USB Link cable(s).

**NOTE** If using a USB isolator, plug the isolator into your computer's USB port, and then plug the USB Link cable into the isolator.
3. To change a router's IP address, subnet mask, or default gateway, set its IP Address DIP switch to Assigned.

4. Start PuTTY.

5. Under Category > Connection, select Serial.

6. Under Options controlling local serial lines, enter the following settings:

<table>
<thead>
<tr>
<th>Field controlling local serial lines</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial line to connect to</td>
<td>Replace X with the computer's port number that the USB Link Kit cable is connected to.</td>
</tr>
<tr>
<td>NOTE</td>
<td>To find the port number, select Start &gt; Control Panel &gt; System &gt; Device Manager &gt; Ports (Com &amp; LPT). The COM port number is beside Silicon Labs CP210x USB to UART Bridge.</td>
</tr>
<tr>
<td>Speed (baud)</td>
<td>115200</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Flow Control</td>
<td>None</td>
</tr>
</tbody>
</table>

7. Click Open. A window similar to the one below appears.

1) Restart
2) Display Modstat
3) IP Address [192.168.1.61]
4) Subnet Mask [255.255.255.0]
5) Default Gateway [0.0.0.0]

8. Do one of the following:
   - To change a property value:
     a. Type the number of the property, then press Enter.
     b. Type the new value, then press Enter.
   - To take an action, type number of the action, then press Enter.

9. If you changed a value, type 1, then press Enter to restart the controller.

10. Close PuTTY.
To set up a Local Access connection in the WebCTRL® interface

For the WebCTRL® application to communicate with the Local Access port, you must do the following:

1. On the **System Configuration** tree, select **Connections**.
2. On the **Configure** tab, click **Add**.
3. From the **Type** drop-down list, select **BACnet Local Access**.
4. Optional: Edit the **Description**.
5. Type the computer's **Port** number that the USB cable is connected to.

   **NOTE** To find the port number, plug the USB cable into the computer's USB port, then select **Start > Control Panel > System > Device Manager > Ports (COM & LPT)**. The COM port number is beside Silicon Labs CP210x USB to UART Bridge.

6. Set the **Baud** rate to 115200.
7. Click **Accept**.
8. On the **View** tab, click the button next to the BACnet/IP network, then select **BACnet Local Access**.
9. Click **Accept**.
10. On the **Configure** tab, select **BACnet Local Access**, then click **Start**.

   **NOTE** If an error message appears, make sure the COM port you selected is not in use. For example, PuTTY may be open and is holding the port open.

11. On the **Network** tree, select the controller that you are connected to.
12. Click , then select **Manual Command**.
13. Type `rnet here` in the dialog box, then click **OK**.
14. On the **Properties** page, click **Module Status**. If a Modstat report appears, the WebCTRL® application is communicating with the controller.
If you have problems mounting, wiring, or addressing the Carrier® ChillerVu™ or the expander, contact Carrier Control Systems Support.

**NOTE** To help you troubleshoot, obtain a Module Status (Modstat) from the controller and review the System Error and Warning details.

---

### Controller LED's

The **Module Status** LED can display the following error codes. Verify the LED patterns by cycling power to the controller and noting the lights and flashes.

<table>
<thead>
<tr>
<th>Error Code...</th>
<th>Indicates...</th>
<th>Possible solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The control program or driver has not been downloaded.</td>
<td>Download All Content to the Carrier® ChillerVu™.</td>
</tr>
<tr>
<td>1</td>
<td>A control program error</td>
<td>Obtain a Module Status Report (Modstat) and look for error conditions. See To get the controller's serial number (page 47) below for instructions on obtaining a Modstat. If you cannot determine the error from the Modstat, contact ALC Technical Support.</td>
</tr>
<tr>
<td>2</td>
<td>The controller’s memory is full</td>
<td>In the WebCTRL® interface, reduce the amount of trend data being stored in the controller. In SiteBuilder, reduce the amount of control programs.</td>
</tr>
<tr>
<td>3</td>
<td>A setup error</td>
<td>Verify:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The address has been set on the rotary switches. See Addressing the Carrier® ChillerVu™ (page 12).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The address is unique on the network</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DIP switches are set correctly</td>
</tr>
<tr>
<td>4</td>
<td>A system error</td>
<td>Obtain a Module Status Report (Modstat) and look for error messages. See To get the controller's serial number (page 47) below for instructions on obtaining a Modstat. If you cannot determine the error from the Modstat, contact ALC Technical Support.</td>
</tr>
<tr>
<td>8</td>
<td>Factory defaults are being restored</td>
<td>The number 8 should display only during the short restoring period. If this number displays continuously or flashes intermittently with another number, try each of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Turn the Carrier® ChillerVu™'s power off, then on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Format the Carrier® ChillerVu™. See Restore factory defaults below.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Download the controller.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Replace the Carrier® ChillerVu™.</td>
</tr>
</tbody>
</table>
Troubleshooting

Other LED's show the status of certain functions.

<table>
<thead>
<tr>
<th>If this LED is on...</th>
<th>Status Is...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power</strong></td>
<td>The Carrier® ChillerVu™ has power.</td>
</tr>
<tr>
<td><strong>Link</strong></td>
<td>The controller is connected to the Ethernet.</td>
</tr>
<tr>
<td><strong>LAN</strong></td>
<td>The Ethernet port is transmitting or receiving data.</td>
</tr>
<tr>
<td><strong>100</strong></td>
<td>The connection speed is 100 Mbps. If LED is not lit, the connection speed is 10 Mbps.</td>
</tr>
<tr>
<td><strong>BACnet transmit</strong></td>
<td>The Carrier® ChillerVu™ is transmitting data over the BACnet/ARC156 network.</td>
</tr>
<tr>
<td><strong>BACnet receive</strong></td>
<td>The Carrier® ChillerVu™ is receiving data over the BACnet/ARC156 network.</td>
</tr>
<tr>
<td><strong>Archive Valid</strong></td>
<td>The controller’s memory backup is valid.</td>
</tr>
<tr>
<td><strong>Port S1 transmit</strong></td>
<td>The Carrier® ChillerVu™ is transmitting data from Port S1.</td>
</tr>
<tr>
<td><strong>Port S1 receive</strong></td>
<td>The Carrier® ChillerVu™ is receiving data on Port S1.</td>
</tr>
<tr>
<td><strong>Battery low</strong></td>
<td>The battery is low.</td>
</tr>
</tbody>
</table>

**Expander LED’s**

The LED’s show the status of certain functions.

<table>
<thead>
<tr>
<th>If this LED is on...</th>
<th>Status Is...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power</strong></td>
<td>The Carrier® ChillerVu™ has power</td>
</tr>
<tr>
<td><strong>Rx</strong></td>
<td>The Carrier® ChillerVu™ is receiving data from the network segment</td>
</tr>
<tr>
<td><strong>Tx</strong></td>
<td>The Carrier® ChillerVu™ is transmitting data over the network segment</td>
</tr>
<tr>
<td><strong>UO#</strong></td>
<td>The binary output is active</td>
</tr>
<tr>
<td><strong>Run</strong></td>
<td>Lights based on expander health. See table below</td>
</tr>
<tr>
<td><strong>Error</strong></td>
<td>Lights based on expander health. See table below</td>
</tr>
</tbody>
</table>

The **Run** and **Error** LED’s indicate expander and network status.

<table>
<thead>
<tr>
<th>If Run LED shows...</th>
<th>And Error LED shows...</th>
<th>Status Is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 flashes per second</td>
<td>Off</td>
<td>Normal</td>
</tr>
<tr>
<td>5 flashes per second</td>
<td>2 flashes per second</td>
<td>Boot is running or driver is updating</td>
</tr>
<tr>
<td>5 flashes per second</td>
<td>On</td>
<td>Fatal error. Replace expander or return for repair.</td>
</tr>
</tbody>
</table>
To restore factory defaults

⚠️ **CAUTION** This erases all archived information and user-configuration settings. You will have to reconfigure all custom settings. It is recommended to restore the factory defaults only under the guidance of Carrier Control Systems Support.

To erase volatile memory data and restore factory default configuration settings:

1. Turn off the Carrier® ChillerVu™'s power switch.
2. Make sure the address switches are not set to 0, 0.
3. Hold down the controller’s Factory Defaults button while you turn its power on.
4. Continue to hold down the Factory Defaults button until the controller displays 8 and then the chase pattern, then release the button.
5. Turn on the Carrier® ChillerVu™'s power switch.

⚠️ **CAUTION** If you have a CCN network and you restore factory defaults, you must download to the Carrier® ChillerVu™ from the WebCTRL® application and NOT upload it. Uploading results in losing your CCN communication.

To get the Carrier® ChillerVu™'s serial number

If you need the Carrier® ChillerVu™'s serial number when troubleshooting, the number is on:

- a sticker on the back of the main controller board
- a Module Status report (Modstat) under Core (or Main) board hardware

To obtain a modstat in the WebCTRL® interface:

1. Select the Carrier® ChillerVu™ in the Network tree.
2. On the Properties page, click Module Status.

To replace the Carrier® ChillerVu™'s battery

The Carrier® ChillerVu™'s 10-year Lithium CR123A battery retains the following data for a maximum of 720 hours during power outages: time, control programs, editable properties, schedules, and trends. To conserve battery life, you can set the driver to turn off battery backup after a specified number of days and depend on the archive function to restore data when the power returns.

A low battery is indicated by the Battery low LED or a low battery alarm in the WebCTRL® application. You can purchase replacement batteries from any retailer that sells a CR-123A battery.
Troubleshooting

1 Verify that the Carrier® ChillerVu™’s power is on.
2 Using a small flathead screwdriver, pry up each side of the black battery clip until it is free and you can remove it.
3 Remove the battery from the controller, making note of the battery’s polarity.
4 Insert the new battery into the controller, matching the polarity of the battery you removed.
5 Push the black clip back onto the battery until you hear both sides click in place.
6 Download the Carrier® ChillerVu™.

To take the Carrier® ChillerVu™ out of service

If needed for troubleshooting or start-up, you can prevent the WebCTRL® application from communicating with the Carrier® ChillerVu™.

1 On the WebCTRL® Network tree, select the Carrier® ChillerVu™.
2 On the Properties page, check Out of Service.
3 Click Accept.
FCC Compliance

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

⚠️ CAUTION  Changes or modifications not expressly approved by the responsible party for compliance could void the user’s authority to operate the equipment.

CE Compliance

⚠️ WARNING  This is a Class A product. In a domestic environment, this product may cause radio interference in which case the user may be required to take adequate measures.
**Document revision history**

Important changes to this document are listed below. Minor changes such as typographical or formatting errors are not listed.

<table>
<thead>
<tr>
<th>Date</th>
<th>Topic</th>
<th>Change description</th>
<th>Code*</th>
</tr>
</thead>
<tbody>
<tr>
<td>4/27/17</td>
<td>Ethernet, BACnet MS/TP, ARC156, and CCN wiring specifications</td>
<td>Added CCN specs</td>
<td>C-TS-JN-E-RD</td>
</tr>
<tr>
<td>2/23/17</td>
<td>Specifications</td>
<td>Changed WS sensors to wireless sensors</td>
<td>C-D</td>
</tr>
<tr>
<td>2/6/17</td>
<td>BACnet Firewall</td>
<td>New topic.</td>
<td>C-OC-RD-O</td>
</tr>
<tr>
<td></td>
<td>Wiring devices to the Carrier® ChillerVu™'s Rnet port</td>
<td>Removed device details and clarified lack of support except in a custom control program.</td>
<td>C-AE-BL-O-WB</td>
</tr>
<tr>
<td></td>
<td>Specifications</td>
<td>changed details for Rnet port</td>
<td>C-D</td>
</tr>
<tr>
<td></td>
<td>Cover</td>
<td>Changed Carrier® ChillerVu™ to new silkscreen</td>
<td>C-D</td>
</tr>
<tr>
<td>7/11/16</td>
<td>To communicate using PuTTY</td>
<td>New topic.</td>
<td>C-D</td>
</tr>
<tr>
<td></td>
<td>To restore factory defaults</td>
<td>Added caution about uploading CCN.</td>
<td>C-D</td>
</tr>
<tr>
<td></td>
<td>To create your system in SiteBuilder</td>
<td>SiteBuilder v6.5 no longer requires you to enter CCN information when it is not a CCN controller.</td>
<td>C-D</td>
</tr>
<tr>
<td></td>
<td>To use a default IP address</td>
<td>Corrected <strong>IP Addr</strong> DIP switch name from Default to DHCP.</td>
<td>C-D</td>
</tr>
<tr>
<td>2/9/16</td>
<td>To attach expanders</td>
<td>Added step explaining jumper settings for connecting more than one expander.</td>
<td>X-TS-RD-E-BR</td>
</tr>
<tr>
<td>12/3/15</td>
<td>To connect to LonWorks network using the SLTA-10</td>
<td>Added step to enter the baud rate in Driver Properties</td>
<td>C-TR-GG-E-JN</td>
</tr>
<tr>
<td></td>
<td>To wire to Modbus RTU on Port S2</td>
<td>Added step to enter the baud rate in Driver Properties</td>
<td>C-TR-GG-E-JN</td>
</tr>
<tr>
<td></td>
<td>Wiring for communications</td>
<td>Correction - BACnet/ARC156 added to table.</td>
<td>C-D</td>
</tr>
</tbody>
</table>

* For internal use only